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Ma tr ic u le 
Nom féminin et masculin qui vient du latin matricula (mère). 

1. N.f. Registre, liste où sont inscrits, avec un numéro d'ordre,  
les noms de toutes les personnes qui entrent dans une collectivité, un groupe ou un système organisé.  

2. N.m. Numéro d'inscription sur un registre matricule. Numéro d'immatriculation.  
 

Matr ic u le s 
Registre imagé et documentaire de l’histoire du Studio XX,  

Matricules propose à la communauté et au public canadien un regard artistique sur notre parcours  
en complémentant notre travail de réflexion critique et historique sur les questions de création,  

de féminisme et d’engagement avec les technologies de la société numérique de demain. 
 
 
 
 

Matricules à été rendu possible grâce à la stratégie de  
Culture canadienne en ligne du ministère du Patrimoine canadien. 
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DOCUMENT « EN TRAITEMENT » 

Les nouveaux documents à ajouter à l’archive Matricules peuvent être placé en traitement 
dans le cas où on ne peut l’intégrer ou le numériser dans l’immédiat. 

Le document devra subir un traitement différent dépendamment de s’il s’agit d’un document 
matériel (physique) ou numérique : 

 Matériel : :  
- Déposer dans la boîte rouge portant la 
mention « À IDENTIFIER, en TRAITEMENT ». 

 
 
Le matériel sera rangé dans cette boîte 
jusqu’à ce qu’on soit prêt à passer à l’étape 
suivante. 
 
 

 Numérique :                
- nommer temporairement le fichier d’un nom 
significatif pour pouvoir l’identifier facilement 
plus tard. 

- déposer le fichier sur le serveur local du 
Studio dans la partition Matricule (ne pas 
confondre avec le serveur  Web qui se trouve 
à l’UQAM). Un mot de passe est nécessaire 
pour se connecter. 

________________________________ 
 
- Aller ensuite dans le dossier 
EN_TRAITEMENT (en rouge). 
 
- Déposer dans le dossier « A_IDENTIFIER », 
(porte aussi la couleur rouge). 
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ASSIGNER UN NUMERO D’ACCESSION A UN DOCUMENT 

• Consulter le document Politique d’archivage Matricules pour comprendre comment est 
composé un numéro d’accession. 

• Ouvrir le document Excel MatriculesDocumentCatalog.xls  
Le fichier se trouve sur la partition Matricule du serveur du Studio XX. 

• Entrer les données requises dans les champs/colonnes selon la procédure établie. 

 

• Pour les documents MATÉRIELS : passer à l’étape Identifier du matériel à l’aide de 
l’étiqueteuse P-Touch. 
 

• Pour les documents NUMÉRIQUES :  
 - renommer le fichier avec son nouveau numéro d’accession. 
 - déposer celui-ci sur le serveur - voir la section Système de classement des  
documents sur le serveur local du Studio. 

- pour une galerie photo, qui constitue un document Matricules avec son numéro 
d’accession, il faut renommer chaque photo constituant la galerie avec le numéro 
d'accession suivi d’un numéro unique (ex. 2007FOR30406O_201.JPG). On peut 
utiliser une application comme Renamer (MAC) pour renommer les fichiers en 
masse. On laisse sur le serveur local toutes les photos, mais on sélectionne entre 10 
et 15 photos qu’on optmise pour le web (réduire la taille et ajuster les couleurs) avant 
de les intégrer dans Drupal. 
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IDENTIFIER DU MATERIEL A L’AIDE DE L’ETIQUETEUSE P-TOUCH 

S’assurer d’avoir en main le numéro d’accession 
préalablement créé dans Excel. 

Le Studio XX s’est doté d’un système d’étiquetage portatif 
« P-Touch ». Cette petite machine imprime des étiquettes 
sur du ruban laminé autocollant. 

L’étiqueteuse P-Touch est rangée dans une boite rouge qui 
entrepose le matériel à identifier. 
La boîte porte la mention suivante: 
« À IDENTIFIER, en TRAITEMENT ». 
 
Avant d’imprimer : s’assurer que les réglages (settings) 
pour la typo (hauteur, espacement …) soit configuré tel 
qu’expliqué dans le petit guide papier à cet effet. La marche 
à suivre y est expliquée en détail.  

Une fois cette étape complétée : 
- imprimer le numéro d’accession  
- coller l’étiquette sur le matériel, idéalement l’enveloppe 
du support. 

 

 

 

 

- Ranger le document celui-ci dans sa boîte d’archives correspondante (par année). 
  
Si ce document matériel doit être numérisé, passez au Guide de numérisation du matériel 
Matricules. 
 
Une fois cette étape complétée, aller à la section Système de classement des documents sur 
le serveur local du Studio pour savoir comment archiver le document numérisé sur le serveur. 
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SYSTEME DE CLASSEMENT DES DOCUMENTS MATRICULES 

 SUR LE SERVEUR LOCAL DU STUDIO 

Le système de classement des archives numériques sur le serveur est détaillé dans le 
document Politique d’archivage Matricules. 

Pour mettre un fichier sur le serveur : 
 
- se connecter au serveur local du studio en choisissant la partition MATRICULE (nécessite un 
mot de passe :_______________________). 
 
- l’arborescence va comme suit : 
  ANNÉE / CATÉGORIE TAXONOMIQUE (FBR, FES, PUB…) 
 
Voici un apperçu : 

 

- déposer le fichier dans le dossier approprié. Le nom du fichier (qui est le numéro 
d’accession) commence toujours par l’année, suivi de sa catégorie taxonomique (FBR, FES, 
PUB…).  
 
Donc, dans l’exemple suivant 2005PRM30325O.mp3  
 - aller dans le dossier 2005, puis  
 - choisir PRM 
 - déposer le fichier à cet endroit 
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AJOUTER UN DOCUMENT MATRICULES DANS DRUPAL 

Sur le site du Studio XX : 
http://www.studioxx.org 

- Ouvrir une session dans Drupal* 
* Il faut tout d’abord posséder quelques 
notions de bases sur le fonctionnement de 
Drupal. Un nom d’usager et mot de passe est 
requis pour pouvoir ajouter/modifier des 
contenus. 

Dans le menu de gauche,  
aller dans Création de contenu puis 
choisir Document Matricules. 
 
Entrer dans les champs, les mêmes 
informations qu’entrées précédemment 
dans le fichier Excel 
(documentspreadsheet.xls). 
 

 
ATTENTION : le champ LANGUAGE doit 
être laissé vide, à moins qu’il y ait deux 
versions traduites d’un même document 
(ex. communiqué de presse PDF). On 
peut spécifier dans le champ Description 
du contenu si l’événement se déroule en 
anglais ou en français (dans le cas d’une 
conférence, entrevue etc…).  
 
C’est seulement lorsqu’on aura à lier ce 
nouveau document à son Événement 
Matricules correspondant qu’on choisira 
la langue. 
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• Déterminer s’il s’agit d’un document de type Audio, Video, Texte ou Image. 
Choisir le champ approprié (le type et l’extention permise sont indiqué juste au-dessus du 
champ).  Remarque : entrer un SEUL TYPE de contenu même si tous les champs sont 
disponibles.  

 

• S’assurer d’être connecté au serveur local du Studio sur la partition MATRICULE. 

• Cliquer sur le bouton BROWSE (parcourir) pour choisir le document (fichier) à intégrer.  
Aller chercher le fichier (préalablement déposé au bon endroit) sur le serveur local – 
partition MATRICULE. 

• Puis cliquer sur UPLOAD pour téléverser le document (fichier) dans Drupal. 
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À noter :  
Intégrer un ficher vidéo QuickTime (.mov) est une longue tâche.  
Calculer environ 30 minutes pour un document de 150-200 MB.  
Attendre le processus complet du téléversement (upload) pour ne pas perdre une partie du 
document lors du transfert. Pour les fichiers légers ( < 20 MB), normalement le temps 
nécessaire ne dépasse pas 5 minutes. 
 

• Documents afférents : 
Il faut faire la distinction entre un Document afférent pour un Document Matricules et un 
Document afférent pour un Événement Matricules. Dans ce cas-ci (Document Matricules), 
un document afférent est la seconde partie d’un vidéo par exemple. On doit d’abord avoir 
intégré le document afférent dans Drupal pour pouvoir ici le sélectionner. Dès la saisie des 
premiers caractères, le petit rond situé à droite se met à tourner, ce qui indique que Drupal 
cherche dans la base de données. Choisir le document afférent voulu. 
 

 

• Cliquer sur le bouton Soumettre pour confirmer et ajouter ce nouveau Document Matricules 
dans l’archive. 

 
  

• Voilà, c’est ajouté ! On peut alors lier ce Document Matricules à son Événement 
correspondant ou encore le lier à son Document afférent s’il y a lieu. 
 
Note : cet ajout se fait dans la base de données. Il se peut qu’en faisant tout de suite une 
recherche du Document il soit introuvable. Drupal fait une mise à jour (refresh) de ses 
données +/- au 60 minutes. C’est donc dire que le Document est bel et bien présent dans la 
base de données mais l’usager n’a pas encore accès à la version actualisée des données. 
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AJOUTER UN EVENEMENT MATRICULES DANS DRUPAL 

• Dans le menu de gauche, aller dans Création de contenu 

• Choisir Event Matricules 
  

 

• Dans le champ Title, entrer le titre exact et officiel de l’Événement à ajouter. 

• Choisir la langue dans laquelle on souhaite intégrer ce nouvel Événement. 
En général, le Studio XX est bilingue pour ses activités, productions et autres. Il faudra donc 
entrer l’Événement 2 fois. Une en français, l’autre en anglais. 

• Galerie photos : s’il existe une galerie de photos qui correspond à cet Événement, entrer ici 
son numéro d’accession. Note : il faut d’abord avoir ajouté cette galerie comme Document 
Matricules dans Drupal. 
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• Ajouter la vignette (thumbnail) de l’Événement. Il s’agit de l’image qui représente 
l’Événement - apparaît dans le site comme tel : 

 
 
La dimension de cette image est de 150 x 150 pixels. 
2 options sont alors possibles pour la création de cette image : 
 

Créer la vignette dans un 
logiciel d’édition d’images dans 
le bon format (150 x 150). 
Optimiser celle-ci pour le web. 
Elle est alors prête à être 
intégrée dans le champ 
suivant : 

Laisser Drupal gérer la création de 
cette vignette. Il n’est alors pas 
nécessaire de passer par un logiciel 
d’édition d’images. Il suffit de choisir 
une image (peut importe la 
dimension) à partir du champ 
suivant :  

      

• Cliquer sur BROWSE (parcourir) pour aller chercher l’image à intégrer. Celle-ci peut être 
localisée sur le poste de travail de votre ordinateur mais elle doit aussi faire partie de la 
galerie photos de l’Événement (en archive).  

• Cliquer sur UPLOAD pour téléverser l’image dans Drupal. 

• De nouveaux champs à remplir apparaîtront alors : 

 

Texte alternatif : texte qui 
remplace l’image si jamais celle-ci 
ne s’affiche pas. 
 
Titre : la description textuelle de 
l’image qui apparaît au passage 
de la souris (mouse over). 
 
La case à cocher « Supprimer » 
permet d’éliminer l’image. 
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• Ajouter une description de l’Événement dans le champ prévu à cet effet : 

 

• 3 options sont offertes pour le Format d’entrée. 
Le choix du Format d’entrée est laissé à la discrétion de l’usager. 
Quelques notions de HTML (système de balises) sont nécessaires pour pouvoir intégrer du 
texte selon une mise en forme voulue (gras, italique, hyperliens…). 

• Lier les documents afférents à l’Événement en entrant les numéros d’accessions dans les 
champs prévus à cet effet. Chaque type de contenu (audio, vidéo, participantes, 
communiqués PDF, programmes PDF) possède un champ à remplir. Il faut donc avoir 
intégré ces contenus préalablement dans Drupal en tant que Document Matricules. 
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• Une fois ces étapes complétées, on est prêt à confirmer l’ajout de ce nouvel Événement. 

• Vérifier si les options de publication sélectionnées correspondent à ce que l’on veut. 
« Placé en page d’accueil » affichera un extrait de l’événement sur la page d’accueil, ce qui 
est souhaitable pour les événements à venir ou récents.  

 

• Cliquer sur le bouton Soumettre pour confirmer et ajouter ce nouvel Événement 
Matricules dans l’archive. 
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AJOUTER UNE ENTITE (ENTITY) MATRICULES DANS DRUPAL 

On désigne par Entité une personne, une artiste très souvent, ou encore une organisation. 
La biographie de l’artiste ou encore le mandat d’une organisation sont ici ajoutée. 

Entrer ici les divers renseignements demandés sur l’Entité : 

Pour accéder à cette vue : 

• Aller dans le menu Création de contenu 
situé à gauche de la page. 

• Choisir Entity.  
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MODIFIER UN ITEM MATRICULES DANS DRUPAL 

Pour modifier un items déjà existant (Document, Événement ou Entity) dans Matricules, suivre 
les étapes suivantes : 

Ouvrir une session dans Drupal* 
http://www.studioxx.org/ 

Choisir le menu administrer > 
gestion du contenu. On peut 
aussi passer par la recherche. 

Choisir l’Événement à modifier 
en cliquant sur son titre. 
 
On se trouve alors en mode 
« Vue » par défaut. 
 
Choisir l’onglet « Éditer » pour 
faire les changements.  

 

Les champs seront alors tous accessibles et modifiables. 
 
Cliquer sur le bouton « Soumettre » pour confirmer les modifications. 

 

 



 
MATRICULES – STUDIO XX 
GUIDE DE NUMÉRISATION 

 
Par Sara Mandana Tizhouch, avril 2008 

 
 
SETTINGS DE CAPTURE/SÉQUENCE DANS LE LOGICIEL DE MONTAGE : 

 
 
 

1. Lancez le logiciel. Connectez la caméra au port Firewire   
       de l’ordinateur. Allez ensuite dans Audio/Video Settings    
       de l’onglet Final Cut Pro : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
2. Dans Sequence Presets, sélectionnez-le    
    preset DV NTSC 48 khz (copy) pour  
    numériser d’une source DV, puis cliquez deux  
    fois pour ouvrir la boîte de dialogue du tableau  
    3. 
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3. Choisissez les options suivantes : 
 
    Frame Rate: 720x480 (3:2) 
    P.A.R: NTSC - CCIR 601 (+ Anarmophic 16:9 s’il     
    s’agit d’une source Widescreen) 
    Field Dominance: None 
    Timebase: 29.97 
 
    Ne cliquez pas sur Ok tout de suite. 
     
 
 
 
 
 
 
 
 
4. Dans Quicktime Video Settings du 
    tableau 3, cliquez sur Advanced pour 
    ouvrir la boîte de dialogue suivante. 
    Assurez-vous que la qualité est à 100% 
    (Best) et que le Scan Mode est 
    Progressive.                                                   
     
    (Changez l’Aspect Ratio à 16:9  

s’il s’agit d’une source Widescreen) 
 
   Cliquez sur Ok. 
 
 
 
 
 

 
 

5. De retour au menu principal de 
    Audio/Video Settings, sélectionnez 
    l’onglet Capture Presets. Choisissez 
    le preset DV NTSC 48 khz (copy) en  
   cliquant deux fois dessus. 
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6. Assurez-vous que sous Quicktime 
    Video Settings, l’option Digitizer lit bien : 
    DV Video + Canon DV.    
 
   Cliquez sur Ok. 
 
 
 
 
 
 
 
 
 
 
 
 
 
    Si vous lisez [Missing] DV Video au lieu,  
    redémarrez la caméra et ensuite le  
    logiciel pour régler ce problème.  
 
 
 
 
 

 
7. Dans Device Control Presets, laissez 
    le setting par défaut à FireWire NTSC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    



 4 

 
 
    Par contre, si vous numérisez d’une source   
    analogue comme la Hi8, sélectionnez l’option 
    Non-Controllable Device pour pouvoir 
    numériser. Ainsi, connectez la caméra Hi8 avec le    
    convertisseur AVC.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 

8. Une fois terminé, allez dans File -> Log & Capture. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

9. Assurez-vous que les presets que vous venez de choisir sont sélectionnés dans Capture Settings. 
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Pour entendre l’audio durant la numérisation, sélectionnez l’option 
Audio sous l’onglet Clip Settings, et ensuite sélectionnez  Preview.  
Assurez-vous que le mode stéréo est également sélectionné (icône des 
2 cercles entrelacés ci-bas).  
 
 
 
 
 
 
 
 

 
 

10.  Appuyez sur le Capture Now de la fenêtre principale et ensuite appuyez sur le Play de la caméra pour    
       commencer à numériser. 

 
11. Une fois la numérisation terminée, appuyez sur Escape (bouton dans le coin supérieur gauche du clavier).     

Le clip apparaîtra dans la fenêtre de projet sous le nom Untitled1. Sauvegardez le projet et renommez la    
       séquence avec le même nom du projet pour pouvoir l’exporter plus tard. 
 
 SETTINGS POUR L’INTRO:   
 
12. Importez le fichier JPEG studioxx_logo_2 et celui dont vous venez de modifier pour l’intro à partir du   
      template psd 2lines ou 3lines. Double-cliquez sur le fichier studioxx_logo_2 pour l’ouvrir dans le Viewer.      
      Une fois dans le Viewer, cliquez sur l’image et appuyez sur la lettre « i ». Ensuite, entrez la donnée    
      suivante: + 400 (+ enter), suivi par la lettre « o ».   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Tout en sélectionnant l’image de la fenêtre   
          Preview, tirez-la en dessous sur la  
          timeline. Elle devrait faire 4 secondes. 
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14. Dans la fenêtre principale des projets, sélectionnez l’onglet Effects.  
      Sous Video Transitions -> Dissolve, choisissez l’effet Fade In Fade    
      Out  Dissolve et tirez-le jusqu’à la timeline en-bas, à la fin du clip du logo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
15. Sélectionnez ensuite le fichier JPEG que vous avez modifié pour l’intro (titre de l’événement, date, etc..),  
      et double-cliquez sur le fichier pour l’ouvrir dans le Viewer.      
      Une fois dans le Viewer, cliquez sur l’image et appuyez sur la lettre « i ». Ensuite entrez la donnée  
      suivante: + 400 (+ enter), suivi de la lettre « o ».   
      Ensuite re-suivez les étapes #13-14, en l’ajoutant directement collé derrière le clip du logo.  
 
       (Vous pouvez également ajuster le type de fondu que vous voulez en sélectionnant un des 3 icônes dans  
       le Viewer (au centre en-haut), soit Beginning, Center ou End.) 
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PROCÉDURE DE MONTAGE : 
 
 
16. Une fois les 2 clips collés ensemble avec les Fade In + Out, ajoutez le clip Untitled1 que vous avez 
numérisé directement après. Rajoutez un Fade In du menu Effects au tout début de la séquence et encore un 
autre à la toute fin (qui dure environ 3 secondes au moins), sur la piste vidéo ainsi que sur les pistes audio 
(Effects-> Audio Transitions -> Cross Fade - 0db). 
 
17.  Tout au long de la séquence, assurez-vous que les niveaux sonores sont corrects. En moyenne, ils   
       devraient lire entre -18 et -6, mais -9 serait idéal.  
       Par contre les bruits de fond ou les ambiances sonores ne devraient pas être aussi élevées.  
 

    
 
 
 
 
 
 
 
 
 
 
  
 
 
     En double-cliquant sur la piste audio de la timeline, la fenêtre du Viewer va faire apparaître l’image ci-  
     dessous. Inscrivez le chiffre 0 (+ enter)  pour le Pan, pour vous assurer que les pistes audio soient bien   
     égales. 
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18. Tout en écoutant la séquence vidéo, si vous remarquez des grosses différences dans les niveaux de  
       l’audio, sélectionnez la lettre P (pour Pen Tool), et insérez des keyframes pour ajuster les niveaux    
      d’audio, en augmentant ou en diminuant les niveaux. 

        
       (Vous pouvez également augmenter la taille de l’aperçu des pistes pour plus de précision en cliquant sur  
        le bouton que la flèche indique en-bas).  
 
        Insérez des keyframes pour corriger les niveaux s’ils augmentent trop à un moment donné, en posant un  
        premier keyframe, suivi d’un deuxième qui descend une ou deux secondes plus tard (donc baisse les  
        niveaux), et puis placez un troisième keyframe là où les niveaux devraient redevenir corrects, suivi d’un  
        dernier keyframe qui revient au même niveau que le reste de la séquence : 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
19. Une fois le montage terminé et l’audio réglé, allez au tout début de la séquence et appuyez sur la lettre 
« i », ensuite allez à la toute fin et appuyez sur la lettre « o ». 
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SETTINGS D’EXPORTATION ET DE COMPRESSION : 
 
 
20. Sélectionnez la fenêtre de la timeline et allez ensuite dans  
       File -> Export -> Using Quicktime    
       Conversion : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
21. La boîte de dialogue suivante s’ouvre. Nommez le document et choisissez l’endroit où le sauvegarder.  
      Cliquez ensuite sur Options. 
 
 
 
 
 
 
 
 
 
 
 
 

Quand la boîte de dialogue suivante apparaîtra, cliquez sur le bouton 
Settings de la section Vidéo :  
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22. Choisissez les options suivantes :  

 
        Compression Type : H.264 
              Frame Rate : 15 fps 
        Key Frames : Automatic 
              Data Rate : Restrict to 465 kbits/sec 
              Optimized for: Streaming 
              (Par défaut si on sélectionne ces settings, la qualité devrait rester  à High, et Encoding à Best      
              Quality -Multi-Pass). 
 
              Cliquez sur Ok. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
23. Dans la boîte de dialogue principale, cliquez sur le bouton Size de la section Vidéo pour ouvrir la fenêtre   
       suivante. Dans Dimensions, choisissez 320x240 QVGA, et Deinterlace Source Video. Cliquez sur Ok. 
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24. De retour dans la boîte de dialogue principale, allez maintenant choisir les Settings de Sound.  
Choisissez les options suivantes : 
 
Format : AAC 
Channels : Mono 
Rate : 32.000 kHz 
Target Bit Rate : 64 kbps 
 
Cliquez sur Ok. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
25. Une fois terminé, le tout devrait ressembler 
à ceci :  
 
Assurez-vous que l’option Prepare for Internet 
Streaming est sélectionnée.  
 
Cliquez sur Ok, ce qui vous ramène à la boîte 
de dialogue initiale de Quicktime Conversion.  
Cliquez sur Save. 
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PROCÉDURE POUR MODIFICATION D’INTRO : 
 
1. Si jamais vous devez changer ou rajouter une nouvelle intro dans un clip déjà compressé,   
    modifiez le document psd dans Photoshop puis sauvegardez-le comme JPEG.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Importez le nouveau document dans Final Cut avec le fichier studioxx_logo_2 et suivez la  
    démarche des paragraphes #12 à 15 à nouveau.   
 
 
 
 
 
 
 
 
3. Une fois terminé, faites-un « i » au début de la séquence et un « o » à la fin.  

        Avec la timeline sélectionnée, allez dans File -> Export -> Using Quicktime Conversion pour exporter   
        l ’intro. Choisissez les même options d’encodage que ceux des paragraphes #21 à 25, avec l’exception    

    du #24 – laissez la boîte de Sound décochée. Cliquez sur Ok et sauvegardez la nouvelle intro. 
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4. Repérez le clip et ouvrez-le dans Quicktime. Faites un CMD-A (Control-All), suivi de CMD-C (Control-   
    Copy).  
    Ouvrez le clip auquel vous voulez rajouter la nouvelle intro. Au tout début du clip, faites un « i » suivi   
    de CMD-V (Control-Paste) pour insérer l’intro. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5. Vérifiez que l’insert est bien et sauvegardez le clip. 
 
NUMÉRISATION D’AUDIO : 
 
1. Ouvrez le logiciel de son. Connectez le lecteur mini-disque avec un câble jack 1/8 de la sortie   

des écouteurs du lecteur à l’entrée du micro de l’ordinateur. Pour un lecteur cassette audio, connectez 
avec un câble RCA les 2 sorties audio du lecteur à l’entrée du micro jack 1/8 de l’ordinateur.  

    Cliquez sur Record pour tester les niveaux. Dans la boîte de dialogue qui apparaît, le Input devrait lire  
    Built-in Input, et le Monitor devrait lire Built-in Output. 
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2. Appuyez sur le Play du lecteur et allez ensuite dans les System Preferences de l’ordinateur (situé dans le    

    Dock) dans la section Sound.  
    Dans Input, assurez-vous que Line In lit bien Audio line-in port. Vous devriez entendre ce qui joue sur le   
    lecteur en même temps.  
     
    Si le volume est trop fort ou trop faible, vous devez ajuster les niveaux à partir du Input Volume, pour  
    qu’en moyenne les niveaux lisent entre le centre de la barre des niveaux (l’échelle) et le haut. S’il est trop   
    proche du haut, le son sera distorsionné.  
    Vous pouvez aussi ajuster les niveaux de lecture directement sur le lecteur de mini-disque. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Une fois réglé, revenez dans le logiciel et appuyez sur le bouton rouge (Record) en-bas de la boîte de 

dialogue (tableau 1) pour commencer la numérisation.  
 

4. Dès que la numérisation est terminée, appuyez sur Ok pour sauvegarder.  
    Choisissez les settings suivants :  
    File Type: AIFF 
    Bit Depth: 16-bits 
    Compressor: None 
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5. Lancez iTunes. Allez dans Edit -> Preferences -> Advanced.  Assurez-vous que dans l’onglet Importing, 
Import Using est MP3 Encoder et le Setting est à Good Quality (128 kbps). 
Importez maintenant vos clips.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Sélectionnez-les et allez dans Advanced (dans la barre du menu) et choisissez Convert Selection to MP3. 
Une fois terminé, les nouveaux clips apparaîtront en dessous des clips à 44.100kHz avec le nouveau 
Sample Rate de 128kbps. 
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Politique d’archivage de Matricules 
En-têtes du catalogage 

 
 
 

 
 

• Trois types d’articles peuvent être catalogués : 
 

1. Un document 
2. Un événement  
3. Une entité (individu ou organisme) 
 

Chacun d’entre eux possède un tableur de catalogage différent et distinct ayant ses 
propres en-têtes. Veuillez vous reporter à la section appropriée selon le type d’article 
à cataloguer.  
 

• Lignes directrices générales : Si vous ne connaissez pas les informations, laissez le 
champ vide. N’inventez rien ou n’émettez aucune hypothèse.  

 
 

 
CHAMPS DU DOCUMENT 
 

* = champ obligatoire 
 

1. * Numéro d’accession : Il s’agit d’un numéro d’identification unique pour le document 
(consultez le document suivant pour de plus amples détails). 

 
2. * Catégories taxinomiques/activités périodiques : sélectionnez depuis la liste (FBR, 

FES, ADM, etc. – voir le document d’accompagnement pour les étiquettes d’article). 
 

3. * Média : sélectionnez depuis la liste (audio, audio/visuel, doc. imprimé, doc. 
électronique,  etc.) 

 
4. * Support : sélectionnez depuis la liste (mini DV, mini Disque, cassette VHS, PDF, etc.) 

 
5. Auteur : Se rapporte à la personne qui a produit l’article. Il ne s’agit pas du nom de la 

personne qui parle dans la vidéo, etc., mais plutôt celui de la personne ou de 
l’institution responsable de la création du document. Par conséquent, pour la plupart 
des documents, l’auteur sera le « Studio XX ». 

 
6. * Titre forgé : Il s’agit de ce qui est écrit exactement sur l’article, peu importe s’il 

reflète ou non le contenu. Aucun jugement ne doit être fait à cette étape du 
catalogage; donc, le Titre est ce qui est écrit à l’espace normal dédié au titre sur 
l’article. Il s’agit donc d’un « titre forgé » et pourrait être quelque chose comme : 
« Femmes branchées/Caméraman : Caroline Martel ». 
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7. * Date : Il s’agit de la date de création du document. Alors, cette date représente la 

date de tournage de la vidéo, la date à laquelle le CD a été gravé, etc. S’il s’agit d’un 
site Web, il s’agit de la date de la dernière visite de cette URL. N.B. Le format de la 
date doit toujours être entré comme suit : MOIS/JOUR/ANNÉE. Si la date est inconnue, 
partiellement inconnue ou si seule l’année n’est indiquée, entre 01/01/ANNÉE ou 
01/01/01. 

 
8. Description physique : il s’agit d'autres renseignements sur les aspects physiques du 

document, tels que la marque, la durée, la longueur, la taille du document, couleur, 
etc. La description physique peut être écrite en français ou en anglais. 

 
9. Description du contenu : si disponible. Par exemple : les personnes enregistrées dans 

le matériel audiovisuel, la description du projet, les références bibliographiques pour 
le matériel publié. La description du contenu peut être écrite en français ou en 
anglais. 

 
10. Documents afférents : Dressent la liste des numéros d’accession de tous les 

documents afférents.  
 

11. Notes de l’archiviste : Il s’agit des notes que la catalogueuse et/ou l’archiviste ont 
écrites. Elles peuvent comprendre tout renseignement que la catalogueuse ou 
l’archiviste trouver pertinent. Par exemple : « Voici le 3e CD d’un boîtier de 5 CD », 
« le CD est rayé », « le boîtier de la cassette est manquant », etc.  

 
12. Emplacement : Par exemple, il s’agit du numéro de la boîte dans laquelle l’article est 

conservé. 
 

 
ÉVÉNEMENTS 
 

1. * Titre : Il s’agit du titre de l’événement. S’il y a des titres différents en anglais et en 
français, entrez les deux titres.  

 
2. Participantes : Dressez la liste des noms des participantes. 

 
3. Subventionnaires : Dressez la liste des noms des subventionnaires (entités). 

 
4. * Date : La date de l’événement. La date de l’événement doit toujours être 

MOIS/JOUR/ANNÉE. 
 
5. Description A : Description de l’événement en français, seulement si disponible. 

Normalement, elle est directement copiée d’une demande de subvention ou du site 
Web, mais elle peut aussi inclure des renseignements pertinents, tels que l’affiliation 
des participants, les renseignements sur les subventionnaires et coproducteurs, etc. 

 
6. Description B : Description de l’événement en anglais, seulement si disponible.  
 
7. Notes de l’archiviste : Il s’agit des remarques internes faites par la catalogueuse ou 

l’archiviste reliées au processus d’archivage ou à l’entrée de données comme les 
problèmes reliés à la clarté des renseignements, aux articles ou aux renseignements 
manquants, etc. 
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8. * Documents afférents : Ce champ comprend les numéros de document de tout 

document qui est relié à cet événement. 
 
 
Entités 
 
Le catalogage de personnes et d’organismes participant aux activités du Studio se fera en 
rapport au processus de recherche dérivée des données entrées dans les champs de 
descriptions, d’auteurs et de participants. 
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Documenter les étiquettes d’article par numéros d’accession 

 
 

Numéros d’accession 
 
Tous les articles devraient être catalogués avec un numéro d’accession qui est présenté de la 
manière suivante :  
 
Année (4 chiffres), étiquette de catalogage (3 lettres majuscules se rapportant aux activités 
du studio), Fonction (un chiffre), numéro d’identification unique (4 chiffres aléatoires, 
commençant par 0001 et subséquemment), État (lettre) 
Exemple : 2001FBR70001M 
 
S’il y a plus d’une copie d’un article, la première étiquette est suivie de « - 1 », la deuxième  
est suivie de « - 2 », etc. 
 
Si vous n’êtes pas certaine de l’étiquette de catalogage, mettez « --- » à la place. 
Exemple : 2003 -- -0003 
 
Catégories taxonomiques/Recurring Activities 
 
FBR = Femmes branchées  
On inclut ici les Métas Femmes branchées (présentations + ateliers) 
 
FES = Festival (Maid in cyberspace/HTMlles) 
 
EVS = Événements spéciaux organisés par le Studio XX 
Incluent toutes formes d’événements de diffusion à l’extérieur de la série des Femmes 
branchées, Méta Femmes branchées et du festival. 
 
PRS = Projets spéciaux produits par le Studio XX. 
Tout projet de recherche, d’intervention et de production produit par le Studio XX.  
 
FOR = Formations (ateliers, formations de maître, enseignements) 
 
RES = uniquement projets des artistes en résidence 
 
COP = coproductions et coprésentations 
Projets, activités, événements d’art, la production a été facilitée par le Studio XX 
 
PUB = publications imprimées ou électroniques (.dpi) qui paraissent telles quelles. 
 
PRM = programmation médiatique telle que les XX Files 
 
ADM = principaux documents administratifs reliés à la structure organisationnelle du studio, 
notamment la charte, la liste des énoncés des mandats, les rapports de l’AGA, la liste de 
l’équipe et les membres du conseil/année, la structure organisationnelle, la programmation 
annuelle et les subventions de production au Conseil des arts du Canada, etc. 
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Fonction  
 
Chaque article de document catalogué peut être identifié sous une des quatre fonctions 
suivantes :  
 
 
Administration : Documents administratifs qui sont à la fois une fonction et une activité. Ils 
comprennent les documents qui sont une copie de secours des documents administratifs. 
Ils sont codés sous la FONCTION 1 
 
Captation/Métrage factuel : comprend tous les documents qui enregistrent des événements, 
alias « documentation ». Exemples : enregistrements d’événements en format vidéo, audio et 
photographiques. 
Ils sont codés sous la FONCTION 3. 
 
Matériels d’accompagnement : Tout document/article qui entoure un événement incluant 
des œuvres d’art, œuvres présentées au Studio, publications tirées des événements, 
déclarations d’artiste, bios. 
Ils sont codés sous la FONCTION 5. 
 
Matériels promotionnels : affiches, cartes publicitaires, articles de presse. 
Ils sont codés sous la FONCTION 7. 
 
Aucune FONCTION particulière : 
Certains projets qui ne peuvent pas être catégorisés selon les quatre FONCTIONS ci-haut 
servent principalement d’activité indépendante (les meilleurs exemples seraient les dpi et les 
sites Web non reliés aux événements ou résidences). 
Ils sont codés sous la FONCTION 0. 
 
 
Statut 
 
Chaque code d’article catalogué indique s’il s’agit d’un document original, d’une copie, d’un 
document de travail ou d’une version imprimée. Certains articles peuvent avoir des versions 
différentes (c.-à-d., un original, une copie, une version de travail), ce qui signifie qu’ils ont le 
même numéro d’accession. En revanche, chaque article aura un code de statut différent. 
 
La terminologie du statut change lorsqu’il s’agit d’un support différent (par ex. : les 
documents audiovisuels vs les documents imprimés et numériques), mais pour faciliter 
l’utilisation des renseignements archivés, Matricules a simplifié les termes en conséquence :  
 
 
O = document original. Il s’agit du premier enregistrement (pour les documents audiovisuels), 
le fichier numérique pour une affiche imprimée, un site Web, etc.  N.B. Aux fins du projet 
Matricules, la version la plus dynamique est l’original. 
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C = Copie (utilisée uniquement pour les enregistrements audiovisuels). Il s’agit d’une copie 
directe du document original. Il est peu probable que le Studio ait plusieurs copies des 
enregistrements audiovisuels. 
 
W = Document de travail. Il s’agit des éléments qui accompagnent la production d’un 
document. Ex. : un fichier de travail électronique pour la conception d’un matériel 
promotionnel. 
 
P = Version électronique (PDF) ou papier pour lesquels il existe un fichier électronique.  
 
Exemple : 
 

• Vous cataloguez une affiche. 
• L’affiche vient-elle avec un fichier numérique? 
• Si oui, alors le fichier numérique est le plus dynamique et par conséquent il est 

étiqueté en tant qu’original. 
• Sinon, l’affiche sera l’original. 
• S’il existe des fichiers/éléments rattachés qui sont partis en production d’un fichier 

numérique, alors ceux-ci deviennent des versions de travail. 
• Le PDF créé durant le processus d’archivage du fichier numérique devient la version 

imprimée de l’article. 
 
Chacune des versions d’un article aura son propre numéro d’accession qui sera identique aux 
documents reliés, sauf dans le cas du code de statut. 
 
S’il existe plus d’une copie d’un même article, la première étiquette est suivie de « - 1 », la 
deuxième étiquette est suivie de « - 2 », etc. 
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Lexique des descriptions 
 
 

 
 

Lorsque vous entrez la description physique et la description du contenu d’un article, utilisez 
un langage cohérent pour assurer la relation entre les articles. 
 
Description physique 
 
En plus de décrire la couleur, la taille et la marque de l’article, la description physique la plus 
précise utilisera les classifications suivantes pour le média et support :  
 
Options de média : 
Audio 
Audio/visuel 
Version imprimée électronique  
Version papier imprimée  
Fichier électronique  
Autre  
 
Options de support : 
Audiocassette  
Classeur  
Livre  
Brochure  
Catalogue  
CD  
DAT  
Multimédia numérique 
Photographe numérique 
DVD  
Disquette   
Hi8  
Invitation  
Journal  
Mini disque  
Mini DV  
PDF  
Photo 
Affiche  
Programme  
Rapport  
Diapositive  
Disque Travan  
VHS  
Disque Zip  
Autre  
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Recommandations 
 
 

 
 

• Les articles d’archives doivent être entreposés par année dans les systèmes 
d’enregistrements numériques et d’entreposage physique. 

 
• Les fichiers numériques doivent être transférés à partir des disques vers le serveur, 

puis vers les archives externes. 
 

• Lorsqu’un fichier existe déjà sur le serveur, une copie sur une disquette n’est pas 
nécessaire. 

 
• Pour le matériel imprimé promotionnel, il est uniquement important de sauvegarder 

environ 10 copies. 
 

• Les fichiers PDF de tous les fichiers possibles doivent être créés et enregistrés dans des 
disques durs externes. 

 
• Les archives des disques durs externes doivent être obligatoirement classées selon le 

système décrit par les numéros d’accession. 
 

• Si possible, n’étiquetez pas les CD ou DVD (au stylo ou avec un collant). Utilisez des 
stylos de qualité pour l’archivage pour étiqueter les disques si nécessaire. 

 
• Pour tous les prochains CD, DVD, cassettes, mini DVD, étiquetez-les avec les 

renseignements suivants : Titre, auteur, date, événement. 
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Autres remarques 
 
 

 
 

 




